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Chapter 1: Introducing Access

In This Chapter
✓ Understanding how databases work

✓ Looking at tables, queries, forms, and other database objects

✓ Creating a database

✓ Opening and closing tables

✓ Designing the tables, queries, forms, and the other parts of a database

The word database is prone to making most people feel kind of queasy. 
Can you blame them? Database terminology — record, field, and filter — 

is the worst of the worst. It even puts other computer terminology to shame. 
Databases intimidate most people. Even brave souls with a considerable 
amount of experience in Word and Excel shy away from Access, the Office 
2010 database program. However, Access can be invaluable for storing and 
organizing customer lists, inventories, addresses, payment histories, donor 
lists, and volunteer lists. What’s more, Access is easy to use, after you get 
the hang of it. No kidding!

This chapter starts you down the road to the Land of Oz. In truth, it intro-
duces databases and the concepts behind databases. It shows you how to 
create a database and database tables for storing information. The second 
half of this chapter explains how to design databases. Sorry, but you have 
to know about database design before you can start fooling with databases. 
You can’t jump right in as you can with the other Office programs.

 

Access offers a practice database called Northwind Traders that you can 
experiment with as you get to know your way around databases. To open 
this database, start Access and select Sample Templates in the Available 
Templates window. Then scroll in the list of sample templates, select 
Northwind, and click the Create button.

What Is a Database, Anyway?
Whether you know it or not, you’re no stranger to databases. The address 
book on your computer is a database. The telephone directory in the desk 
drawer is, too. A recipe book is also a database in that recipes are catego-
rized under different headings. If you ever arranged a CD collection in a 
certain way — in alphabetical order or by musical genre, for example — you 
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created a database of CDs, one that makes finding a particular CD easier. 
Any place where information is stored in a systematic way can be consid-
ered a database. The only difference between a computerized database and 
a conventional database, such as a telephone directory, is that storing, find-
ing, and manipulating data is much easier in a computerized database.

Imagine how long it would take to find all the New York addresses in an 
address list with 10,000 entries. In Access, you can query a 10,000-entry data-
base and find all New York addresses in a matter of seconds. For that matter, 
you can query to find all the addresses in a certain ZIP Code. You can put 
the list in alphabetical order by last name or in numerical order by ZIP Code. 
Doing these chores without a computer requires many hours of dreary, 
monotonous labor.

Tables, Queries, Forms, and Other Objects
One problem with getting to know a database program — and the primary 
reason that people are intimidated by databases — is that you can’t jump 
right in. You have to know how data is stored in a database and how it is 
extracted, to use programmer terminology. You have to know about objects, 
Access’s bland word for database tables, queries, forms, and all else that 
makes a database a database. To help you get going, these pages offer a 
crash course in databases. They explain the different objects — tables, que-
ries, forms, and reports — that make up a database. Fasten your seat belt. 
If you complete the crash course without crashing, you’re ready to create 
your first database.

Database tables for storing information
Information in databases is stored in database tables like the one in Figure 
1-1. In a database table, you include one field for each category of informa-
tion you want to keep on hand. Fields are the equivalent of columns in a 
table. Your first duty when you create a database table is to name the fields 
and tell Access what kind of information you propose to store in each field. 
The database table in Figure 1-1 is for storing employee information. It has 
seven fields: ID, First Name, Last Name, E-mail Address, Business Phone, 
Company, and Job Title.

A database can comprise one database table or many different tables that 
are linked together. If you’re dealing with a lot of information, storing data in 
more than one table is to your advantage. Later in this chapter, “Separating 
information into different database tables” explains why storing data across 
several database tables is advantageous.
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Figure 1-4: 

A report 

gathers 

data for 

scrutiny and 

analysis.

 

Creating a Database File
Creating a database is a lot of work, at least in the beginning. You have to 
design the database (a subject that I explain shortly). You have to enter the 
raw information into the tables. You have to construct queries that allow 
yourself and others to read meaning into the data (see Chapter 4 of this 
mini-book). By contrast, creating a database file for storing the information 
is the easy part.

Access offers two ways to create a new database file. You can do it from 
scratch or get the help of a template. With a template, some of the work is 
done already for you. The template comes with prefabricated queries, forms, 
and reports. However, templates are for people who already know their way 
around Access databases. To make use of a template, you have to know how 
to modify a preexisting database.

 Before you create a database file, start by deciding where in your computer 
to store it. Unlike other Office programs, Access requires you to save and 
name a new file as soon as you create it.

Creating a blank database file
Follow these instructions to create a blank database file:

  1. Start Access (if it isn’t already running), or go to the File tab and 
choose New.

  The Available Templates window appears.
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 2. Click the Blank Database icon.

 3. Click the folder icon (it’s in the lower-right corner of the window 
beside the File Name text box), and in the File New Database dialog 
box, select the folder where you want to keep the database file, enter 
a name in the File Name text box, and click OK.

 4. Click the Create button.

  The Navigation pane and a blank table appear. Later in this chapter, 
“Finding Your Way Around the Navigation Pane” explains what this pane 
is all about. I suggest you go there without delay or deferral.

Getting the help of a template
As I explain earlier, templates are wonderful if you have the wherewithal 
to modify them. Access offers prefabricated databases for tracking 
assets, keeping inventory, scheduling resources, and doing other things. 
Unfortunately, the only way to find out whether one of the templates is 
worthwhile is to go to the trouble to create a database from a template, open 
up the database file, and look around.

Follow these steps to create a database file from a template:

  1. Start Access or go to the File tab and choose New.

   The Available Template window opens.

 2. Click the Sample Templates icon.

 3. Select a template.

  The template name appears on the right side of the window.

 4. Click the folder icon (it’s in the lower-right corner of the window 
beside the File Name text box), and in the File New Database dialog 
box, select the folder where you want to keep the database file, enter 
a name in the File Name text box, and click OK.

 5. Click the Create button.

Finding Your Way Around the Navigation Pane
The first thing you see when you open most database files is a Navigation 
pane like the one in Figure 1-5. This is the starting point for doing all your 
work in Access. From here, you can select an object — that horrible word 
again! — and begin working. Tables, queries, and other objects you create 
are added to the Navigation pane when you create them.
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 ✦ Finding objects: Use the Search bar (located at the top of the Navigation 
pane) to search for objects.

 ✦ Opening and closing the Navigation pane: Click the Shutter Bar Open/
Close button on the upper-right corner of the Navigation pane (or press 
F11) when you want to shrink it and get it out of the way. You can also 
resize this pane by clicking the far-right edge and dragging it left or right.

Designing a Database
Being a database designer isn’t nearly as glamorous as being a fashion 
designer, but it has its rewards. If you design your database carefully and cor-
rectly, it can be very useful to you and others. You can enter information accu-
rately. When the time comes to draw information from the database, you get 
precisely the information you need. These pages explain everything you need 
to consider when designing a database. Pay close attention to “Separating 
information into different database tables,” later in this chapter, because the 
hardest part about designing a database is deciding how to distribute informa-
tion across database tables and how many database tables to have.

Deciding what information you need
The first question to ask yourself is about the kind of information you want 
to get out of the database. Customer names and addresses? Sales informa-
tion? Information for inventory tracking? Interview your co-workers to find 
out what information could be helpful to them. Give this matter some seri-
ous thought. Your goal is to set up the database so that every tidbit of infor-
mation your organization needs can be recorded.

 

A good way to find out what kind of information matters to an organization 
is to examine the paper forms that the organization uses to solicit or record 
information. These forms show precisely what the organization deems 
worthy of tracking in a database. Figure 1-6, for example, shows the paper 
form that players fill out to sign up for a baseball league whose database 
tables appear in Figure 1-7. Compare Figure 1-6 with Figure 1-7, and you can 
see that the Players, Teams, and Divisions database tables all have fields for 
entering information from this form.

Separating information into 
different database tables
After you know the information you want to record in the database, think 
about how to separate the information into database tables. Many are 
tempted to put all the information into a single database table, but because 
Access is a relational database, you can query more than one table at a time, 
and in so doing, assemble information from different tables.



Chapter 2: Building Your 
Database Tables

In This Chapter
✓ Creating database tables

✓ Creating fields for a database table

✓ Choosing a primary key field

✓ Using field properties to make data entries more accurate

✓ Indexing fields in a table

✓ Forming relationships between tables

Database tables are the building blocks of a database. They hold the 
raw data. Relationships between the tables permit you to query and 

generate reports from several different tables. How well your database 
tables are put together and how accurately data is entered in the tables 
determine whether your database is a thing of beauty or a wilted flower.

This chapter explains how to create database tables and fields for the 
tables. It explains what primary key fields are and how primary key fields 
and indexed fields make it easier for Access to sort, search, and query a 
database. This chapter describes how to forge relationships between tables. 
Fasten your seat belts. In this chapter, you find numerous tips and tricks for 
making sure that data is entered accurately in your database tables.

Creating a Database Table
Raw data is stored in database tables (or in a single table if you decide to 
keep all the data in one place). The first and most important part of setting 
up a database is creating the tables and entering the data. After you enter 
the data, you can harass your database for information about the things and 
people your database keeps track of. If you haven’t done so already, read 
the sections in Chapter 1 of this mini-book that pertain to storing informa-
tion and designing a database before you create a database table. Chapter 
1 of this mini-book explains what database tables are and how to fashion a 
splendid one.
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Figure 2-1: 

Fetching a 

table from 

another 

database.

 

 5. On the Tables tab, select the database table you want.

  You can import more than one database table by clicking several table 
names or clicking the Select All button.

 

 You can import a table structure — its field names and formats — with-
out importing the data in the table. To do so, click the Options button 
in the Import Objects dialog box, and under Import Tables, select the 
Definition Only option button.

 6. Click OK.

 If the table you want to import includes lookup fields, import the tables or 
queries that the lookup fields refer to as well as the table itself. Without 
those tables or queries, the lookup fields won’t be able to obtain any values. 
Later in this chapter, “Creating a lookup data-entry list” explains what 
lookup fields are.

Opening and Viewing Tables
To open a table, start in the Navigation pane and select the Tables group 
to view the names of database tables you created. How you open a table 
depends on whether you want to open it in Datasheet view or Design view. 
Figure 2-2 illustrates the difference between these views. Datasheet view is 
for entering and examining data in a table; Design view is for creating fields 
and describing their parameters.
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Figure 2-2: 

A table in 

Design view 

(top) and 

Datasheet 

view 

(bottom).

 

Select a table on the Navigation pane and use one of these techniques to 
open and view it:

 ✦ Opening in Design view: Right-click the table’s name in the Navigation 
pane and choose Design View on the shortcut menu.

 ✦ Opening in Datasheet view: On the Navigation pane, double-click the 
table’s name or right-click its name and choose Open on the shortcut 
menu.

 

  

 ✦ Switching between views with the View button: On the Home tab, click 
the View button. This button changes appearance, depending on 
whether you’re in Design view or Datasheet view.

 ✦ Switching between views on the status bar: Click the Datasheet View or 
Design View button on the right side of the status bar.

 ✦ Switching between views by right-clicking: Right-click the table’s title 
bar and choose Datasheet View or Design View.

Entering and Altering Table Fields
After you create a database table, the next task is to enter the fields, or if 
Access created the table for you, alter the fields to your liking. As Chapter 
1 of this mini-book explains, fields represent categories of information in a 
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To remove a primary key, click its row selector and then click the Primary 
Key button all over again.

Moving, renaming, and deleting fields
Suppose that you need to move, rename, or delete a field. To do so, switch 
to Design view and follow these instructions:

 ✦ Moving a field: Select the field’s row selector (the box to its left) and 
release the mouse button. Then click again and drag the selector up or 
down to a new location.

 ✦ Renaming a field: Click in the Field Name box where the name is, delete 
the name that’s there, and type a new name.

  ✦ Deleting a field: Click in the Field Name box, go to the (Table Tools) 
Design tab, and click the Delete Rows button. You can also right-click 
the field and choose Delete Rows on the shortcut menu.

Field Properties for Making Sure 
That Data Entries Are Accurate

Unfortunately, entering the data in a database table is one of the most 
tedious activities known to humankind. And because the activity is so dull, 
people are prone to make mistakes when they enter data in a database table. 
One way to cut down on mistakes is to take advantage of the Field Properties 
settings on the General tab in the Design view window. Figure 2-4 shows the 
General tab.

 

Figure 2-4: 

Establishing 

field 

properties.

 

Description of the propertyField properties

These properties determine what can and can’t be entered in the different 
fields of a database table. Some of the settings are invaluable. The Field Size 
property, for example, determines how many characters can be entered in a 
field. In a State field where two-letter state abbreviations are to be entered, 
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 3. Select the table with the data you need and click the Next button.

  The dialog box shows you a list of available fields in the table.

 4. Select the field where the data for your list is stored.

 5. Click the > button.

  The name of the list appears on the right side of the dialog box, under 
Selected Fields.

 6. Click the Next button.

  Normally, lists are displayed in ascending order, but you can select 
a field and click the Ascending button to reverse the order of the list. 
(Note that the button turns into the Descending button.)

 7. Click the Finish button.

  If you’re so inclined, you can change the width of the list before clicking 
Finish, but you can always do that on the datasheet, as Chapter 3 of this 
mini-book explains.

 

Suppose that you obtain the items from the wrong field or wrong database 
table? To fix that problem, select the field for which you created the list, 
and in Design view, select the Lookup tab (refer to Figure 2-8). Choose Text 
Box rather than Combo Box on the Display Control drop-down list and start 
all over.

Indexing for Faster Sorts, Searches, and Queries
Indexing means to instruct Access to keep information about the data in a 
field or combination of fields. Because Access keeps this information on 
hand, it doesn’t have to actually search through every record in a data-
base table to sort data, search for data, or run a query. In a large database 
table, indexes make sorting, searching, and querying go considerably faster 
because Access looks through its own data rather than the data in tables. 
The performance difference between querying a database table that has and 
has not been indexed is astonishing. That’s the good news. The bad news is 
that indexes inflate the size of Access files.

By default, the field you choose as the primary key field is indexed. I recom-
mend choosing other fields for indexing if you often conduct queries and 
searches. When you choose a field to index, choose one with data that varies 
from record to record and is likely to be the subject of searches, sorts, and 
queries. That way, the index means something. However, a field with data 
that is mostly the same from record to record is a waste of a good index, not 
to mention hard drive space. By the way, Access automatically indexes fields 
whose names include the words ID, Code, Num, and Key, the idea being that 
these fields are likely to store essential information worthy of indexing.
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555Establishing Relationships between Database Tables

 2. On a blank line in the dialog box, enter a name for the index in the 
Index Name column.

 3. In the Field Name column, open the drop-down list and choose the 
first field you want for the multifield index.

  Access sorts the records first on this field and then on the second field 
you choose.

 4. In the next row, leave the Index Name blank and choose another field 
name from the drop-down list.

  This field is the second field in the index. You can use as many as ten 
different fields in a multifield index. In Figure 2-9, two fields are in a mul-
tifield index: First Name and Last Name.

 5. Choose Descending in the Sort Order column if you want the field 
sorted in descending order.

  Most of the time, you want leave the Sort Order set to Ascending 
because most people read from A to Z.

 6. Click the Close button.

  Click the Indexes button in Design view if you need to return to the 
Indexes dialog box and change how fields are indexed.

Establishing Relationships between Database Tables
As Chapter 1 of this mini-book explains, you have to establish relationships 
between tables if you want to query or generate reports with data from more 
than one database table. Relationships define the field that two different 
tables have in common. To understand why relationships between tables 
are necessary, consider the query shown in Figure 2-10. The purpose of this 
query is to list all companies that ordered items in 2009, list the companies 
by name, and list the city and country where each company is located.

Consider what Access does to run this query:

 ✦ Access deals with two database tables, Customers and Orders.

 ✦ In the Orders table, Access looks in the Order Date field to isolate all 
records that describe orders made in the year 2009. The expression 
for finding these records is shown on the Criteria line in Figure 2-10: 
Between #1/1/2009# And #12/31/2009#.

 ✦ Because there is a relationship between the ID field in the Customers 
table and the Customer ID field in the Orders table — because the two 
fields hold the same type of information — Access can match the 2009 
records it finds in the Orders table with corresponding records in the 
Customers table. Where the Customer ID of a 2009 record in the Orders 
table and an ID in the Customers table match, Access assembles a new 
record and places it in the query results.



Chapter 3: Entering the Data

In This Chapter
✓ Entering data on a datasheet

✓ Changing the look of a datasheet

✓ Creating a form for entering data

✓ Finding records in a field or database table

✓ Finding and replacing your data

At last — you can start entering the data. If you set up your database 
tables, named the fields, and established relationships between the 

tables, you’re ready to go. This short chapter explains how to enter the 
data in a database table. It shows you how to enter data on a datasheet or 
enter data by way of a form. This chapter also describes how to find missing 
records in case one goes astray.

There’s no getting around it: Entering data is truly a tedious activity. But 
if you set up the fields well and take advantage of input masks and other 
field properties, it isn’t so bad. It’s better than stepping on a shovel blade, 
anyway.

The Two Ways to Enter Data
When it comes to entering data in a database table, you can take your pick 
between Datasheet view and a form. Figure 3-1 compares and contrasts the 
two. Here are the advantages of entering data in Datasheet view:

 ✦ Many records appear simultaneously.

 ✦ You can compare data easily between records.

 ✦ You can sort by column with the commands in the Sort and Filter group 
on the Home tab (as discussed in Chapter 4 of this mini-book).

 ✦ You can scroll up or down to locate records.

Here are the advantages of entering the data in a form:

 ✦ You don’t have to scroll left or right to see all the fields.

 ✦ Getting from field to field is easier.

 ✦ Fields are clearly labeled so that you always know what to enter.
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Figure 3-1: 

Entering 

records in 

Datasheet 

view (left) 

and in a 

form (right).

 

Entering the Data in Datasheet View
Entering data in Datasheet view is like entering data in a conventional table. 
As with a table, a datasheet has columns and rows. Records are entered in 
rows, and each column represents a field. Fans of Datasheet view like being 
able to look at a dozen records simultaneously. They like being able to open 
subdatasheets. (Chapter 2 of this mini-book explains what those are.) For 
fans of Datasheet view, these pages explain how to enter data in a datasheet 
and change a datasheet’s appearance.

  Database tables open in Datasheet view when you double-click their names 
in the Navigation pane. But if you happen to be gazing at a table in Design 
view, click the View command on the Home tab or the Datasheet View 
button on the status bar.

Entering data
In Datasheet view, the bottom of the window tells you how many records are 
entered in the database table and which record the cursor is in. To enter a 
new record, move to a new, empty row and start entering the data. To create 
a new row, do one of the following:
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 ✦ Resizing columns: Move the pointer between column names at the 
top of the datasheet, and when you see the double-headed arrow, click 
and start dragging. To make a column just large enough to fit its widest 
entry, move the pointer between column names and double-click when 
you see the double-headed arrow.

 ✦ Changing fonts: The default font for a datasheet is Calibri 11-point, but 
the Home tab offers commands for changing fonts and font sizes. Look 
for these commands in the Text Formatting group.

  ✦ Changing the look of gridlines: On the Home tab, open the drop-down 
list on the Gridlines button and choose options to change the number 
and thickness of gridlines.

  ✦ Alternate row colors: Open the drop-down list on the Alternate Row 
Color button and choose a color for alternating rows on the datasheet.

To experiment all at one time with the many options for changing a data-
sheet’s appearance, go to the Home tab and click the Text Formatting group 
button. You see the Datasheet Formatting dialog box, as shown in Figure 3-2. 
If you want a customized look for all the datasheets you work on, click the 
File tab and select Options. Then go to the Datasheet category in the Options 
dialog box and go to town.

 

Figure 3-2: 

The 

Datasheet 

Formatting 

dialog box.

 

Entering the Data in a Form
Forms like the one shown in Figure 3-3 are very convenient for entering data. 
The labels tell you exactly what to enter. Personally, I prefer entering data in 
a form to entering data on a datasheet. On a form, you take it one step — 
make that one record — at a time. Not looking at a dozen records makes 
the task of entering data a little easier. These pages explain how to create a 
form for entering information in a database table. You also get tried-and-true 
advice for moving around with the Navigation buttons.
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Entering the data
To open a form and begin entering data in its database table, display the 
form’s name in the Navigation pane and then double-click the form’s name. 
You can also right-click the name of the form and choose Open.

 To enter data in a form, click the New (Blank) Record button. This button 
is located with the Navigation buttons at the bottom of the form window. A 
new, empty form appears. Start typing. Press the Tab key, press the Enter 
key, or click to move from field to field. You can move backward through the 
fields by pressing Shift+Tab. If you enter half a record and want to start over, 
press the Esc key to empty the current field. Press Esc again to empty all the 
fields.

The Navigation buttons at the bottom of the form window tell you how many 
records are in the database table and which record you’re looking at. From 
left to right, the Navigation buttons take you to the first record, previous 
record, next record, and last record.

Finding a Missing Record
Sometimes data goes astray. You scroll through a datasheet but simply can’t 
find the item or record you need so bad. For times like those, Access offers the 
Find command. Use the command to scour a database for errant information.

  Open the database table with the data that needs finding. If you know in 
which field the data is located, click in the field. You can save a little time 
that way. Then, on the Home tab, click the Find button (or press Ctrl+F). You 
see the Find and Replace dialog box, as shown in Figure 3-4. Fill in the dialog 
box as follows:

 

Figure 3-4: 

Finding 

data.

 

 ✦ Find What: Enter the item you’re looking for. If you’re looking for a null 
value, enter null in this text box. Enter “” (two double-quotation marks) 
to find zero-length strings. Table 3-2 describes the wildcard characters 
you can use in searches.



Book VI

Chapter 3

E
n

te
rin

g
 th

e
 D

a
ta

571Finding and Replacing Data

 

To quickly find the first value of a search term, start typing in the Search box 
in the form window or in Datasheet view. As soon as you start typing, the 
cursor moves to the first instance of the data you enter.

Finding and Replacing Data
Finding and replacing data is remarkably similar to finding data. The differ-
ence is that you enter data in the Replace With text box as well as the famil-
iar Find What text box and other option boxes. Figure 3-5 shows the Replace 
tab of the Find and Replace dialog box. Does it look familiar? If it doesn’t, 
read the preceding topic in this chapter.

 

Figure 3-5: 

Replacing 

data.

 

  To find and replace data, go to the Home tab and click the Replace button 
(or press Ctrl+H). You see the Replace tab of the Find and Replace dialog 
box. After you enter the replacement data in the Replace With text box, 
make sure that Whole Field is selected in the Match drop-down list. 
Conducting a find-and-replace operation with Any Part of Field or Start of 
Field selected in the Match drop-down list can have unintended conse-
quences. For example, a search for Brook also finds Brooklyn, Middlebrook, 
and other words that include brook. Blindly replacing the brook text string 
with stream produces, for example, Streamlyn and Middlestream.

 Unless you’re as confident as a gambler with four aces, don’t click the 
Replace All button to replace all instances of the text or numbers in the data-
base table or field you’re searching in. Instead, click the Replace button to 
find and replace text or numbers one instance at a time.

 

You can also find and replace data with an update query. Chapter 4 of this 
mini-book covers update queries.



Chapter 4: Sorting, Querying, 
and Filtering for Data

In This Chapter
✓ Sorting, or rearranging, records in a database table

✓ Filtering records in a table to see only the records you need

✓ Querying to collect and examine information stored in a database

✓ Looking at different kinds of queries

Now that you’ve laid the groundwork, you can put your database 
through its paces and make it do what databases are meant to do — 

provide information of one kind or another. This chapter explains how to 
pester a database for names, addresses, dates, statistical averages, and 
what not. It shows how to sort records and filter a database table to see 
records of a certain kind. You also find out how to query a database to get it 
to yield its dirty little secrets and invaluable information.

Sorting Records in a Database Table
Sorting rearranges records in a database table (or subdatasheet) so that 
the records appear in alphabetical, numerical, or date order in one field. 
By sorting the records in a database, you can locate records faster. What’s 
more, being able to sort data means that you don’t have to bother about the 
order in which you enter records because you can always sort them later to 
put them in a particular order.

Ascending versus descending sorts
Records can be sorted in ascending or descending order:

 ✦ Ascending order: Arranges records in alphabetical order from A to Z, 
numbers from smallest to largest, and dates chronologically from earli-
est to latest.

 ✦ Descending order: Arranges text from Z to A, numbers from largest to 
smallest, and dates chronologically from latest to earliest.
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 Sorting records
Follow these steps to sort the records in a database table:

 1. In Datasheet view, click anywhere in the field by which you want to 
sort the records.

  2. On the Home tab, click the Ascending or Descending button.

  You can also right-click a field name at the top of a column and choose 
Sort A to Z or Sort Z to A on the shortcut menu. The menu choices 
change based on the type of data. For Number fields, you can sort small-
est to largest and vice versa; for Date fields, choose to sort oldest to 
newest, or vice versa.

 

You can sort on more than one field by clicking a field and sorting it, and 
then clicking a second field and sorting it. Just make sure that you sort the 
fields in reverse order. For example, to sort the database by the Employee, 
Customer, and Order ID fields, click in Order ID and sort it in ascending 
order; click in Customer and sort it in ascending order; click in Employee 
and sort it in ascending order. If you mess up and forget how the table is 
sorted, click the Remove Sort button. This button is located on the Home tab 
underneath the Sort A to Z and Sort Z to A buttons.

Filtering to Find Information
Filtering isolates all the records in a database table that have the same field 
values or nearly the same field values. Instead of all the records in the table 
appearing on the datasheet, only records that meet the filtering criteria 
appear, as shown in Figure 4-1.

 

Figure 4-1: 

Results of 

a filtering 

operation.

 Filter indicators



580 Querying: The Basics

Querying: The Basics
Querying means to ask a question of a database and get an answer in the 
form of records that meet the query criteria. Query when you want to ask a 
detailed question of a database. “Who lives in Los Angeles and donated more 
than $500 last year?” is an example of a query. So is “Which orders were 
purchased by people who live in California and therefore, have to pay sales 
tax, and how much sales tax was charged with these orders?” A query can 
search for information in more than one database table. For that matter, you 
can query other queries for information. A query can be as sophisticated or 
as simple as you need it to be. In the results of the query, you can show all 
the fields in a database table or only a few necessary fields.

Access offers several different ways to query a database (the different tech-
niques are described later in this chapter in “Six Kinds of Queries”). Still, 
no matter which kind of query you’re dealing with, the basics of creating 
and running a query are the same. You start on the Create tab to build new 
queries. To open a query you already created, double-click its name on 
the Navigation pane. The following pages introduce you to queries, how to 
create them, and how to modify them.

Creating a new query
To create a new query, start on the Create tab and click the Query Design or 
Query Wizard button.

  ✦ Create the query in Design view: Click the Query Design button to see 
the Query Design window, shown in Figure 4-4, as well as the Show Table 
dialog box for telling Access which database tables to query. Construct 
your query in the Design window (the following pages explain how).

  ✦ Create the query with a wizard: Click the Query Wizard button to dis-
play the New Query dialog box and then choose a wizard option (four 
possible Query Wizards are available) and answer the questions that the 
Query Wizard asks. You’re asked which table or tables to query, which 
fields to include in the query, and which fields to include in the query 
results (the following pages explain these issues).

  To run a query, open the query in the Query window, go to the (Query 
Tools) Design tab, and click the Run button. The results of the query appear 
in Datasheet view.



Book VI

Chapter 4

S
o

rtin
g

, Q
u

e
ryin

g
, a

n
d

 

Filte
rin

g
 fo

r D
a

ta

587Six Kinds of Queries

Access places number signs (#) around date criteria after you enter it. You 
can enter dates in these formats:

 ✦ 11/22/10

 ✦ 11/22/2010

 ✦ 22-Nov-10

 ✦ November 22, 2010

 For the purpose of entering two-digit years in dates, the digits 30 through 99 
belong to the 20th Century (1930–1999), but the digits 00 through 29 belong 
to the 21st Century (2000–2029). For example, >4/1/24 refers to April 1, 2024, 
not April 1, 1924. To enter a date in 1929 or earlier, enter four digits rather 
than two to describe the year: >4/1/1929. To enter a date in 2030, or later, 
enter four digits rather than two: >4/1/2038. To avoid any confusion, enter 
four-digit years all the time.

 

The Date() function can come in very handy when you want to retrieve data 
relative to today’s date, whatever it happens to be. For example, to retrieve 
purchase orders made between January 1, 2007, and today’s date, enter this 
expression: Between 1/1/2007 And Date().

At last — saving and running a query
To save a query and inscribe its name forever in the Navigation pane, click 
the Save button on the Quick Access toolbar and enter a descriptive name 
in the Save As dialog box. The name you enter appears in the Queries 
group in the Navigation pane.

After you laboriously construct your query, take it for a test drive. To run a 
query:

  ✦ Starting from the Query Design window: Click the Run button on the 
(Query Tools) Design tab.

  ✦ Starting from the Navigation pane: Double-click an existing query’s 
name, or right-click its name and choose Open on the shortcut menu.

Six Kinds of Queries
For your pleasure and entertainment, the rest of this chapter describes six 
useful types of queries. Access offers a handful of other queries, but I won’t 
go there. Those queries are pretty complicated. If you become adept at que-
rying, however, you’re invited to look into the Help system for advice about 
running the query types that aren’t explained here.



Chapter 5: Presenting Data 
in a Report

In This Chapter
✓ Creating a new report

✓ Opening a report

✓ Changing the look of a report

The prettiest way to present data in a database table or query is to 
present it in a report. Even people who are allergic to databases can 

put up with database material in a report. Reports are easy to read and 
understand. They succinctly present the data so that you and others can 
interpret it. This brief chapter explains how to create reports, open them, 
and edit them.

Creating a Report
Access comes with all kinds of complicated tools for fashioning your own 
report — for laying out the pages in different ways and making data fields 
show up in different parts of the page. If ever a task called for relying on a 
wizard, creating a report is it. You can save yourself a lot of trouble, and 
fashion sophisticated-looking reports as well, by dispensing with the fancy 
report-making tools and letting the wizard do the job.

 

What’s more, the easiest and best way to make a report is to base your 
report on a query. As part of fashioning a report with a wizard, you can tell 
Access which database tables and which fields to get the data from — in 
other words, you can query your database from inside the Report Wizard. 
However, doing that requires turning somersaults and cartwheels. It’s far 
easier to run a query to produce the results you want in your report, save 
your query, and then fashion a report from the query results. Chapter 4 in 
this mini-book explains how to create a query.



Book VI

Chapter 5

P
re

se
n

tin
g

 D
a

ta
 

in
 a

 R
e

p
o

rt

595Tweaking a Report

 

Figure 5-1: 

An example 

of a report.

 

Opening and Viewing Reports
If you’ve spent any time whatsoever in Access, you know the drill for open-
ing a so-called object. Follow these steps to open a report:

 1. In the Navigation pane, select the Reports group.

  You see the names of reports you created.

 2. Double-click a report name or right-click a name and choose Open 
from the shortcut menu.

  The report appears in Report view.

 

To update a report so that it includes recently added data, go to the Home 
tab and click the Refresh All button.

Tweaking a Report
As I mention at the start of this chapter, Access offers a bunch of complex 
tools for changing the layout and appearance of a report. If you’re coura-
geous and have lots of time on your hands, you’re invited to take these tools 
in hand and go to it. In the Reports group of the Navigation pane, right-click 
a report and choose Layout View on the shortcut menu. Your report appears 
in Layout view, as shown in Figure 5-2. In this view, using tools on the Report 
Layout Tools tabs, you can tweak your report’s appearance.


